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Thank you for purchasing a 3G Turbo Stick from Bell. This two-in-one 
Turbo Stick with memory storage (microSD card sold separately) will 
give you access to Canada’s largest 3G network.1

This guide provides an overview of your new Turbo Stick and details 
on how to configure your computer for use with this Turbo Stick.

•	 Getting started
•	 Installing the Mobile Connect Basic software for Windows
•	 Activating your 3G Turbo Stick
•	 Using your 3G Turbo Stick
•	 Using a Macintosh with the 3G Turbo Stick
•	 Hardware overview
•	 Inserting and removing the 3G Turbo Stick from your computer
•	 Inserting and removing a microSD card
•	 Saving files to microSD
•	 Troubleshooting

Welcome

Getting started
Before activating your Turbo Stick, ensure you have the following:

•	 �A Bell wireless account with a Mobile Internet plan. (If you don’t  
have an account or a Mobile Internet plan, speak with a Bell account 
representative to get set up.)

•	 �Your Mobile Directory Number (MDN)/  
phone number	 ____________________

•	 Your Mobile Station ID (MSID)	 ____________________
•	 Your unlock code	 ____________________
•	 �Your Electronic Serial Number (ESN),  

located on the Turbo Stick bar code label	 ____________________



Operating system	 Microsoft® Windows XP or Windows Vista™**

USB ports	 1 type A USB port

Communication ports	 2 free COM ports

I/O resources	 1 IRQ, 4,096 bytes of I/O space

Memory	 128 MB

Disk space	 20 MB

Operating system	 Macintosh OS 10.4 or later with Intel CPU

USB ports	 1 type A USB port

Communication ports	 N/A

I/O resources	 N/A

Memory	 256 MB

Disk space	 20 MB

SYSTEM REQUIREMENTS     

SYSTEM REQUIREMENTS     

For PC users. To install and operate your Turbo Stick, 
ensure your computer has the following system resources:

For Macintosh users. To install and operate your Turbo Stick, 
ensure your computer has the following system resources:

** �For Windows Vista 64-bit support, please visit our website at bell.ca/mobileconnect for the 
latest version of Mobile Connect Basic.



Installing the Mobile Connect Basic software 
for Windows
Mobile Connect Basic from Bell is a software application that allows 
you to manage your wireless connections over the 3G network.  
This software is preloaded onto the Turbo Stick and can be installed  
on your computer; no CD required. Alternatively you can download the 
latest software from our website at bell.ca/mobileconnect

Windows Vista: Ensure that “User Account Controls” (UAC) is disabled. 
This setting is found in the User Accounts section of the Control Panel 
under the Start Menu.  Check your Windows Vista help files for more 
information about using this Windows Vista feature.

Installation du logiciel Connexion mobile  
de base pour Windows

You may need to restart your computer after changing this setting.

If you do not disable User Account Controls before inserting the Turbo 
Stick, Mobile Connect Basic will indicate that no device is attached. 
To correct this problem:

• Remove the Turbo Stick from the computer
• �Go to Start > Programs > Bell > Mobile Connect Basic and select Uninstall, 

if the program appears in the menu
• �Follow the instructions above to disable User Account Controls (UAC) if 

you have not already disabled
• Restart the computer
• �After the restart, ensure UAC is disabled before continuing  

with the installation

User Account Controls can be re-enabled after installation is complete 
and your Turbo Stick is working. 



1.	 �Insert the Turbo Stick into an available USB port on your computer. 
The installation will begin automatically or you will be prompted to 
install Mobile Connect Basic.

	� Select Install/Run Mobile Connect Basic. If the auto install fails to start,
use an alternate Internet connection to download and install the 
software from our website at bell.ca/mobileconnect, or you can 
manually install the software by: 
1.	 Selecting Start > Run > Browse... 
2.	 Look in “My Computer” to find Turbo Stick disk drive
3.	 Run the file “carrier.exe”

Note: The drive letter assigned to the Turbo Stick by the computer’s 
operating system will be the next available drive letter (e:\, f:\, g:\, etc.)



2.	 �Follow the InstallShield® Wizard. It will guide you through the process 
of installing the Mobile Connect Basic application. Use the Next and 
Back buttons to navigate through the installation. To continue with 
the installation, you must click Agree to accept the terms of the 
License Agreement. 
 
 
 
 
 
 
 
 
The installation process may take several minutes to complete with 
no progress shown on the progress bar – please be patient.

3.	� Select Restart or Finish to complete the installation. Once the 
installation procedure is complete, you may be required to restart your 
computer. If a restart is not required, Mobile Connect Basic will launch 
automatically. If your computer restarts, launch the Mobile Connect 
Basic application by clicking on the Mobile Connect Basic icon.



1.	 �When Mobile Connect Basic runs it will check if your Turbo Stick has 
been activated. Your Turbo Stick must be activated and you must 
subscribe to a Mobile Internet plan for your Turbo Stick to operate 
on the Bell Mobility network. Mobile Connect Basic will begin the 
automatic activation process.  

This process takes several minutes, please be patient.

2.	 �Mobile Connect Basic is now ready to use. The main screen  
will appear.  
 
 
 
 
 
 
 
Should the process fail, Mobile Connect Basic will prompt you to 
retry the automatic activation or to try manual activation.

 

Activating your 3G Turbo Stick 



For manual activation, you will need the following information:

•	 Your Mobile Directory Number (MDN) / phone number

•	 Your Mobile Station ID (MSID) (usually the same as your MDN)

•	 Your unlock code (The default unlock code is “111111”)

Use the Activation Wizard under the Tools menu (wrench Icon) to enter 
your unlock code. Type the six-digit number into the field provided and 
click Next.



Mobile Connect Basic will then prompt you to enter your Mobile 
Directory Number (MDN) and Mobile Station ID (MSID). Enter these two 
numbers into the fields provided.

After successful first-time activation the main screen will appear. 



To disconnect, click the Disconnect button.

From the Mobile Connect Basic main program window, you can 
establish a network connection and view the status. Some of the key 
indicators and buttons include:

To connect to the Internet, click the Connect button on the Mobile 
Connect Basic main program window.

Using your 3G Turbo Stick

Note: To disable roaming and only connect to the Bell Mobility network, 
select Home Only in the Roaming Selection entry in the Tools Menu.

A.  Connect/Disconnect

B.	  Signal strength

C.	  Status display

D.	  Usage counters

E.	  Minimize button

F.	  Tools menu

G.	  Roaming indicator

Connect or disconnect from the network

Graphically illustrated network signal status

Indicates the availability of the network and status of 
current network connection

An overview of the data you have transmitted and received 

Minimize Mobile Connect Basic to the Windows® System Tray 

Select various configuration options, set preferences or 
reactivate your modem

Notification that your network connection is with a Bell 
partner network (roaming rates will apply)
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To install Mobile Connect, insert the Turbo Stick into an available USB port on 
your computer. Do not forcibly insert the Turbo Stick as this may damage both 
the Turbo Stick and the port. The Turbo Stick powers on when inserted.

The Turbo Stick will appear as a CD on your desktop, 

• double-click this icon  
• drag the MobileConnect.dmg installation file to your desktop   
• double-click to open the .dmg file 
• double-click the MacOS folder, and then the MobileConnect.dmg file 
• drag the Mobile Connect icon to a suitable location on your hard drive

Double-click the Mobile Connect icon to launch the program. You may need  
to remove the Turbo Stick.

When you start Mobile Connect for the first time you will need to enter your 
name and password and click OK.

To continue the installation, you must read and click Agree to accept the terms 
of the License Agreement.

Follow the instructions to install the software drivers for the U760 Turbo 
Stick.  You may need to re-enter your name and password, and restart your 
computer during the installation process.  Double-click the Mobile Connect icon 
to continue after restarting.

Once the installation procedure is complete, you will be prompted to re-insert 
your Turbo Stick (if it is not already in your computer’s USB port). Mobile 
Connect will initialize, scan for your Turbo Stick, and the main program window 
will appear.

When Mobile Connect runs, it will check if your Turbo Stick has been activated 
on the Bell network. The Turbo Stick will attempt to auto-activate if necessary, 
or prompt you for your phone number and unlock code for a manual 
activation.  You can also start the Activation Assistant manually under the Tools 
menu. The Turbo Stick must be activated and in an area with network coverage 
to operate on the Bell Mobility high speed data network.

NOTE: If you need but do not have the unlock code, try the default “111111” 
before calling for support.

Using a Macintosh with the 3G Turbo Stick



From the Mobile Connect main program window you can establish a network 
connection and view the status. 

Some of the key indicators and buttons include:

 

A.  �Connect/Disconnect 
button

B.  �Signal strength  
indicator

C.  Status display

D.  Usage counters

E.  Minimize button

F.  Tools menu

G.  Roaming indicator

Connect or disconnect from the network

Graphically illustrated network signal status

Indicates the availability of the network and status of 
current network connection

An overview of the data you have transmitted and received

Minimize Mobile Connect to the System Tray

Select various configuration options and set preferences

Notification that your network connection is with a Bell 
partner network (additional roaming charges will apply)

To connect to the Internet, click the Connect button on the Mobile Connect 
main program window. To disconnect, click the Disconnect button.

To download the full Mobile Connect user manual or software updates, please 
visit bell.ca/mobileconnect



Hardware overview

Your Turbo Stick

1.	 Protective cap

2.	 LED indicator

3.	 External antenna connector

4.	 MicroSD slot

5.	 USB connector 

Your new Turbo Stick must be handled with care to ensure reliable 
operation. The following handling guidelines are recommended:

• 	 �Do not apply adhesive labels to the Turbo Stick; they may cause 
the Turbo Stick to overheat and may alter the performance of the 
antenna.

• 	 �The USB connector should plug easily into your computer’s  
Type A USB port. Forcing the Turbo Stick into a port may damage  
the connector.

• 	 Protect the Turbo Stick from liquids, dust and excessive heat.

• 	 �Store the Turbo Stick in a safe place with the protective cap on 
when not in use.

1.

3.

4.

5.

2.



The Turbo Stick can be inserted or removed from your computer  
at any time.

As an external device, the Turbo Stick is vulnerable to damage during 
transport. It is recommended that you remove and securely store it 
when transporting your computer.

To insert your Turbo Stick:

1.	 Remove the protective cap from the Turbo Stick.

2. 	�Insert the Turbo Stick into the USB port. Do not forcibly insert the Turbo 
Stick, as this may damage both the Turbo Stick and the USB port.

3.	The computer will beep.

4.	�Start Mobile Connect Basic from the desktop or from the  
AutoPlay prompt.

5.	The Turbo Stick powers on when inserted.

To remove your Turbo Stick:

1.	 Disconnect and exit Mobile Connect Basic from the tools menu.

2.	Carefully remove the Turbo Stick from the USB port.

3.	The computer will beep.

Using your Turbo Stick on another computer: The Turbo Stick can be 
used on multiple computers. Simply insert it and install the Mobile 
Connect Basic software on each new computer you wish to use. 

Note: Data network usage is tied to the Turbo Stick and usage between 
computers is cumulative and will be billed together. 

Inserting and removing the 3G Turbo Stick  
from your computer



Inserting and removing a microSD card

The Turbo Stick is equipped with removable memory storage. This feature 
gives you the ability to store data simultaneously to an external drive 
without the need for another flash drive. 

A microSD card (sold separately) is required to take advantage of the 
memory storage feature. It is recommended that the Turbo Stick be 
unplugged when inserting or removing a microSD card.

Inserting a microSD card:

1.	 Locate the microSD slot.

2.	 �Remove the plastic microSD slot protection insert and be careful not to 
lose it.

3.	 Align the microSD card with the slot.

4.	 Carefully insert the microSD card until it clicks into place.

Removing a microSD card:

1.	� Gently push the card in, release, and it will pop out.

2.	 �Insert the plastic microSD slot protection insert.



Saving files to microSD

The process of saving files to the microSD memory card on your 
Turbo Stick is similar to saving files to any external flash drive on your 
computer.

Saving files from an application:
1.	 �Insert the Turbo Stick into your computer’s USB port.
2.	 �The computer will detect new hardware and the Unplug/Eject icon 

will appear in the taskbar.
3.	� Go to File > Save As.
4.	 �Click the down arrow within the Save in box to view the contents of 

the pull-down menu.
5.	 �Select the Turbo Stick which appears as a drive letter for Mass 

Storage or Removable Storage (e:\, f:\, g:\, etc.) 
6.	 �Type a name for the file you are saving to the Turbo Stick and click 

Save.

Lanyard & keychain:
The lanyard & keychain is a convenient accessory that gives you 
maximum portability while on the go.

Affixing the lanyard or keychain to the Turbo Stick:
1.	� Remove the cap and locate the lanyard hook on the Turbo Stick and 

on the cap.
2.	 �Pinch the looped thread on the lanyard or keychain and insert the tip 

of the thread into the hook hole on the cap and through the Turbo Stick, 
pushing the thread until it exits on the other side of the hook hole.

3.	 �Push the cap on the Turbo Stick and insert the end of the lanyard or 
keychain through the loop. Pull to tighten.



Troubleshooting
Below is a list of common error messages and possible solutions 
regarding the use of your Turbo Stick. Refer to bell.ca/mobileconnect 
for complete details. 

Intermittent connectivity  
and/or low throughput

•	�Relocate the entire computer to a different area.

The LED is green but 
the Turbo Stick is not 
recognized by the 
computer

•	�Remove and re-insert the Turbo Stick into a different USB port
•	�Use a USB extension cable to ensure good connection.
•	�The driver installation may have been corrupted, refer to  
bell.ca/mobileconnect for additional troubleshooting tips.

Bell core network or Bell  
high speed network does  
not show in the status  
display

and/or

The LED indicator on the  
Turbo Stick glows red

•	�Service may not be available in your location. Relocate the 
computer to a different area. Coverage maps are available at 
bell.ca/coverage

•	�The network may be unavailable due to maintenance. Try the 
connection again at a later time.

•	���The Turbo Stick may not be inserted properly. Remove and reinsert 
the Turbo Stick into the port.

•	�Your computer may not have the correct hardware drivers for 
the USB port. Remove the Turbo Stick, uninstall Mobile Connect, 
download and install the latest version of Mobile Connect Basic 
for your device from bell.ca/mobileconnect 

When clicking Connect, the 
message “Your connection 
attempt to the network  
failed” is displayed

•	�Service may not be available in your location. Relocate the 
computer to a different area. Coverage maps are available at 
bell.ca/coverage

•	�The network may be unavailable due to maintenance. Try the 
connection again at a later time.

•	�The Turbo Stick may not be activated or the phone number 
supplied may be incorrect. First, attempt the activation process 
again, as described in the section Activating your Turbo Stick 
in this guide. If this does not resolve the problem, contact Bell 
Client Care.

The LED indicator on the  
Turbo Stick is not lit

•	�The Turbo Stick may not be inserted properly. Remove and 
firmly reinsert the Turbo Stick into the port. Try using a USB 
extension cable.

•	�Your computer may not have the correct hardware drivers for 
the USB port. 

The LED indicator on the  
Turbo Stick glows amber

•	�Remove and firmly reinsert the Turbo Stick into the port.
•	�Shut down and restart the computer.
•	�If the above actions do not resolve this problem, contact  

Bell Client Care.

Symptoms	 Solution



Speeds may vary with your technical configuration, Internet traffic, server, environmental conditions 
or other factors. Novatel Images: ©2009. Novatel Wireless, Inc. All rights reserved. Ovation, 
Novatel Wireless and the Novatel Wireless logo are trademarks of Novatel Wireless, Inc. Designed 
in the United States of America. Microsoft, Windows and Windows Vista are registered trademarks  
and/or trademarks of Microsoft Corporation in the United States and/or other countries.  
InstallShield is a registered trademark or trademark of Macrovision Corporation in the United States 
of America and/or other countries. All other brands and product names are trademarks of their 
respective holders. System requirements for laptops: Microsoft Windows XP or Vista operating system, 
1 Type A USB port, 2 free COM ports; I/O resources: 1 IRQ, 4096 bytes of I/O space, memory: 128 MB and 
disk space: 20 MB. Macintosh OS X 10.4 and above, 1 Type A USB port, memory: 256MB and disk space: 
20MB. (1) Based on total square kms of the 1xEVDO vs HSPA coverage as of June 3, 2009.

You may also contact Bell Wireless Data Support at: 

1 877 DATA-123 (1 877 328-2123)




